PulseNet Standard Operating Procedure for PulseNet MLVA
of Escherichia coli 0157 (STECO157) — Applied Biosystems
Genetic Analyzer 3500 Platform

1. PURPOSE:
To describe the standardized laboratory protocol for molecular subtyping of E. coli 0157 (STEC
0157).

2. SCOPE

To provide PulseNet participants with a single protocol for performing MLVA of STEC 0157, thus
ensuring inter-laboratory comparability of the generated results using the Applied Biosystems
Genetic Analyzer 3500 platform.

3. DEFINITIONS:

3.1. MLVA: Multiple-locus variable-number tandem repeat analysis
3.2. VNTR: Variable-number tandem repeat

3.3. DNA: Deoxyribonucleic acid

3.4. DNase: Deoxyribonuclease

3.5. PCR: Polymerase chain reaction

3.6. HPLC: High purity liquid chromatography

3.7. dNTP: Deoxyribonuclotide triphosphate

3.8. CDC: Centers for Disease Control and Prevention

3.9. SOP: Standard Operating Procedure

4. RESPONSIBILITIES/PROCEDURE

4.1. Biosafety Warning
4.1.1.STEC 0157 with an infectious dose as low as 100 cells is a human pathogen causing serious
disease. Always use a minimum of Biosafety level 2 practices and extreme caution when
transferring and handling strains of this serotype. Work in a biological safety cabinet when
handling large amounts of cells. Disinfect or dispose of all plastic ware and glassware that
come in contact with the cultures in a safe manner.

4.2.Reagents, supplies, and equipment needed for DNA template preparation
4.2.1.Trypticase soy agar with 5 % sheep blood (TSA-SB) or comparable media
4.2.2.1 yl and 10 pl inoculation loops
4.2.3.0.5 ml microcentrifuge tubes
4.2.4.DNase-free, molecular biology -grade water
4.2.5.Vortex
4.2.6.Boiling water bath or thermal block / thermocycler accommodating 0.5 ml tubes
4.2.7.Tabletop centrifuge for high rpm (up to 13,000-14,000 rpm) spinning
4.2.8.Pipets (200 pl) for aliquoting 100 pl of DNase-free, molecular biology-grade water
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4.2.9.Filtered Sterile Pipet tips

4.3.Reagents, supplies, and equipment needed for PCR
4.3.1.DNA lysates from isolates (store at -20°C or -80°C freezer for long term)
4.3.2.PCR primers (see appendix PNL28-1)
4.3.2.1. Fluorescent-labeled forward primers
4.3.2.1.1. HPLC-purified
4.3.2.2. Unlabeled reverse primers
4.3.2.2.1. Regular gel filtration purification
4.3.2.3. Biosearch Technologies (Novato, CA; www.biosearchtech.com; 1-800-436-6631)
sells primers labeled with the three dyes needed for the protocol
4.3.24. Divide the concentrated stocks in portions and store at -80°C freezer
4.3.2.4.1. One vial should contain enough to prepare 25-50 pl of working solution.
Avoid repetitive freeze-thaw cycles of concentrated primer stocks.
4.3.2.5. The 1.0 uM, 2.5 uM, 5.0 uM, and 25 pM working solutions can be stored at either -
20°C or -80°C freezer
4.3.2.6. Prepare new working solutions every month or if a significant drop in the
fluorescence level is observed (for instructions refer to PNQO6_MLVA ABI certification,
appendix PNQO06-5)
4.3.3.96-well polypropylene PCR plates (Fisher, Cat. No. 07-200-613) or Microamp PCR tubes
without caps (Life Technologies, Cat. No. N8010533)
4.3.4.8-well strip caps for polypropylene plate (Fisher, Cat. No. 07-200-639) or MicroAmp strip caps
for individual tubes (Life Technologies, Cat. No. N8010535)
4.3.5.DNase-free, molecular biology -grade water
4.3.6.1.5 ml Eppendorf microcentrifuge tubes
4.3.7.PCR Nucleotide mix (ready-to-use dNTP mix containing all four nucleotides; Roche, Cat. No. 11
814 362 001)
4.3.8.Platinum Taq Polymerase with 50 mM MgCl, and 10X buffer (Life Technologies Cat. No.
10966-034)
4.3.9.PCR cooling block (VWR International, Cat. No. 62111-762)
4.3.10. DNA Engine (Bio-Rad), GeneAmp (Life Technologies) or similar thermocycler with a heated
lid option and 96-well block format
4.3.11. Parafilm M, 4” width (VWR, Cat. No. 52858-032)
4.3.12. Complete set (1000 pl, 200 ul, 100 pl, 20 w, 10 ul, and 2 pl) of single channel pipettors for
mastermix set-up (“clean set”)
4.3.13. A 1-10 pl single channel pipettor for adding DNA templates
4.3.14. Filtered tips for pipettors
4.3.15. Microfuge for low (up to 6,000 rpm) rpm spinning

4.4.Reagents, supplies and equipment needed for Genetic Analyzer 3500
4.4.1.DNase-free, molecular biology -grade water
4.4.2.PCR cooling block (VWR International, Cat. No. 62111-762)
4.4.3.10 pl, 100 pl, and 1000 pl single channel pipettors
4.4.4.1-10 pl and 20-200 pl multichannel pipettors
4.4.5 Filtered pipette tips
4.4.6.Sterile solution basins
4.4.7.1.5 ml Eppendorf microcentrifuge tubes
4.4.8.96-well polypropylene (non-PCR) V-bottom plate (for dilutions; Fisher Scientific, Cat. No. 07-
200-698)
4.4.9.MicroAmp Optical 96-well reaction plates (Life Technologies, Cat. No. 4306737)
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4.4.10. 96-well plate base (Life Technologies, Cat. No. 4317237)
4.4.11. Rubber septa for 96-well reaction plates (Life Technologies, Cat. No. 4315933)
4.4.12. 96-well plate retainer (Life Technologies, Cat. No. 4317241)
4.4.13. Hi-Di Formamide, 25 ml (Life Technologies, Cat. No. 4311320)
4.4.14. GeneFlo 625 DNA size standard — ROX, 800 ul (Chimerx, Cat. No. 3125-02)
4.4.15. Multi-Capillary DS-30 (Dye Set D) Matrix Standard Kit (Life Technologies, Cat. No. 4345827)
4.4.15.1. Needed periodically to establish the system dye color spectra for the instrument.
Required when analyzing fragments labeled with FAM, HEX, NED, and ROX.
4.4.15.2. NOTE: DS-33 Matrix Standard (Dye set G5, required for analyzing
fragments labeled with FAM, VIC, NED, PET, and LIZ) is typically installed as
default as part of the instrument installation process
4.4.15.3. Inorder to install the DS-30 Matrix, follow the instructions of the kit insert and the
“Getting Started Guide”, chapter “Performing a Spectral Calibration”
4.4.16. 3500 24 Capillary Array 50 cm (Life Technologies, Cat. No. 4404689)
4.4.17. Genetic Analyzer Cathode Buffer Container (4 pack), 1X (Life Technologies, Cat. No.
4408256)
4.4.18. Genetic Analyzer Anode Buffer Container (4 pack), 1X (Life Technologies, Cat. No. 4393927)
4.4.19. 3500 Conditioning Reagent (Life Technologies, Cat. No. 4393718)
4.4.20. 3500 POP7 Performance Optimized Polymer (384 samples) (Life Technologies, Cat. No.
4393708)
4.4.21. Parafilm M, 4” width (VWR, Cat. No. 52858-032)
4.4.22. Centrifuge with a microtiter plate rotor
4.4.23. Heating block or thermal cycler accommodating a 96-plate for denaturation
4.4.24. Microfuge for low (up to 6,000 rpm) rpm spinning

4.5.Isolate preparation

4.5.1.DAY 0
4.5.1.1. Streak an isolated colony from pure test cultures to TSA-SB plate (or comparable
media). Incubate cultures at 37°C for 14-18 hrs.
4.5.2.DAY 1

4.5.2.1. For each isolate to be typed, aliquot 100 pl of sterile, molecular biology-grade water
into 0.5 ml microfuge tubes. Use a sterile, disposable 1 pl loop to pick 2-3 colonies (about
half of a loop-full); rotate the loop in the microfuge tube to release the bacteria into the
water. Cap and vortex for 10-15 seconds to disperse any clumps.

4.5.2.2. Place the tubes in a 100°C water bath or heat block for 10 minutes. Cool briefly on
ice or in fridge and centrifuge for 10 minutes at 10,000 rpm. Place on ice or in fridge
while preparing PCR reactions. These DNA templates can be stored at -20°C or -80°C for
several years.

4.6.PCR procedure
4.6.1.DAY 1
4.6.1.1. Fill out, save with the run name, and print a PCR template worksheet (see appendix
PNL28-2) with appropriately labeled samples (a maximum of 46 isolates/plate; 44
unknowns + two positive controls and a negative control; two wells are reserved for the
internal ladder).
4.6.1.1.1. For each isolate, two wells must be labeled as follows: BNkeyR1 where
“BNkey” represents the isolate-specific state laboratory identification number (be
sure to use the exactly same isolate ID that is used in the PFGE gels uploaded to the
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national database) and “R1” represents one of the two specific multiplex PCR
reactions (R1, R2).
4.6.1.2. Fill out, and print a PCR mastermix calculation worksheet (see appendix PNL28-3)
by typing the number of isolates to be tested (plus 2-3 extra) in the PCR mastermix
calculators labeled R1 and R2. This number is highlighted in red and is next to “number
of samples to be analyzed”. The mastermixes for reactions 1 and 2 (R1, R2) for one
sample are as follows:

R1 Volume (ul)  Final conc
PCR water 5.30

PCR buffer (10x) 1.00 1x
MgCl; (50 mM) 0.40 2.0 mM
dNTPs (10 mM) 0.20 0.20 mM
VNTR-3F (25 pM) 0.27 0.67 uyM
VNTR-3R (25 uM) 0.27 0.67 uM
VNTR-34F (5 uM) 0.24 0.12 uyM
VNTR-34R (5 uM) 0.24 0.12 yM
VNTR-9F (5 pM) 0.24 0.12 uyM
VNTR-9R (5 uM) 0.24 0.12 uyM
VNTR-25F (2.5 uM) 0.20 0.05 uM
VNTR-25R (2.5 pM) 0.20 0.05 uM
Taq (5 U/ul) 0.20 1.00U
Total volume 9.00
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R2 Volume (ul)  Final conc
PCR water 5.92
PCR buffer (10x) 1.00 1x
MgCl; (50 mM) 0.40 2.00 mM
dNTPs (10 mM) 0.20 0.20 mM
VNTR-17F (2.5 uM) 0.30 0.15 uM
VNTR-17R (2.5 pM) 0.30 0.15 uM
VNTR-19F (12.5 uM) | 0.16 0.016 uM
VNTR-19R (12.5 uM) | 0.16 0.016 uM
VNTR-36F (2.5 uM) 0.11 0.011 uM
VNTR-36R (2.5 uM) 0.11 0.011 uM
VNTR-37F (2.5 uM) 0.07 0.017 uM
VNTR-37R (2.5 puM) 0.07 0.017 uM
Taq (5U/ul) 0.20 1.00U
Total volume 9.00

4.6.1.2.1. NOTE: these primer concentrations serve as a starting point.

Since laboratory-specific factors, such as the age of the primer stocks,
calibration status of the thermocyclers and pipettes, etc. affect
amplification efficiency, each laboratory will have to re-optimize the
primer concentrations for optimal detection of all targets. However,
any other parameters stated in the SOP should not be changed.

4.6.1.3. Thaw all reagents and supplies needed for PCR reactions and place on ice; keep
primers light protected as much as possible.
4.6.1.3.1. NOTE: PCR mastermixes should be set up in a clean hood that is
dedicated just for this purpose and where no cultures or DNA are
handled.
4.6.1.4. Prepare the two separate PCR mastermixes in 1.5 ml Eppendorf tubes following the

instructions in the PCR mastermix calculation worksheet (see appendix PNL28-3) and

place on ice. Add the mastermix components in the following order: water, 10x PCR

buffer, Mg,Cl, dNTPs, primers, and then finally Taq polymerase. Mix the reaction mixture

by vortexing briefly.

4.6.1.4.1. Vortex all reagents except Taq polymerase before adding to the mastermix.
Taqg may be briefly centrifuged with low rpm, if necessary, to pull the enzyme down
to the bottom of the tube.
4.6.1.5. Place a 96-well PCR plate or required number of PCR tubes in a PCR cooling block.
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4.6.1.6. Dispense 9.0 pul of each mastermix into the appropriate columns of the 96-well
polypropylene plate / PCR tubes as noted in the PCR template worksheet (see appendix
PNL28-2)

4.6.1.7. Add 1 ul of PCR water to each of the two different wells representing the negative
controls of the two reactions.

4.6.1.8. Add 1.0 pl of DNA lysate to each of the two different wells representing the two PCR
reactions. Use STEC 0157 strain EDL933 (ATCC 43895) as a positive control (it is
recommended to run the positive control in duplicate). The internal ladder to be used
will be comprised of pooled PCR products of the isolates EC04PN0139 and EC04PN0570
(see appendix PNL28-4 for instructions for ladder preparation)

4.6.1.9. Cover all wells / tubes with 8-well strip caps and firmly clamp down to avoid any
evaporation during PCR amplification.

4.6.1.10. Recommendation: briefly spin down the plate / tubes to remove any air bubbles.

4.6.1.11. Setup the following PCR parameters and save the program as “O157MLVA”:

o Stepl 95°C for 5 minutes
e Step?2 94°C for 20 seconds
o Step3 65°C for 20 seconds
o Step4 72°C for 20 seconds
e Step5 Go to Step 2, 34x
e Stepb6 72°C for 5 minutes
o Step7 Indefinite hold at 4°C
4.6.1.11.1. Make sure to use the heated lid option on the PCR block and “calculated” or

tube control (instead of block or probe control) as a temperature control method.
4.6.1.12. When the PCR is complete, store the amplification products light-protected at 4°C
until ready to run on the sequencer. If the fragment analysis is not performed the same
day, the plate should be stored at -20°C or -80°C. The PCR products are stable for
approximately one month, when stored frozen.

4.7.Initial setup of Genetic Analyzer 3500 instrument
NOTE: Steps 4.7 only needs to be performed before the very first run. In future
runs continue directly to step 4.8.
4.7.1.Click on the “3500” icon to open the 3500 Data Collection Software. The software will open a
window and the main screen will display the “Dashboard”. If the connections are functioning
properly, the status light on the sequencer will be green, the “State” of the instrument will be
“Idle”, and all of the consumables should have the number of days/samples remaining for each
item.
4.7.2.Setting up the Size Standard
4.7.2.1. Click on the “Library” icon at the top right of the screen.
4.7.2.2. At the left-hand side of the screen select the “Size Standards” menu option.
4.7.2.3. At the top of this screen select “Create” in the toolbar

4.7.2.4. A new window will appear and in the box next to “Size Standard” enter in
“GeneFlo625”

4.7.2.5. From the “Dye Color” drop-down menu select “Red”

4.7.2.6. In the “Enter new Size Standard definition” box enter the fragment sizes for each

peak (refer to the GeneFlo 625 product insert for the peak sizes). Separate each size
using a comma.
4.7.2.7. When finished, click the “Add Size(s)” button, then click “Save” and “Close”
4.7.3.Setting up Run Parameters:
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4.7.3.1. Once the fragment sizes have been assigned the Assays, File Name Conventions, and
Results Group will need to be set up.
4.7.3.1.1. Assays
4.7.3.1.1.1. At the left-hand side of the screen select the “Assays” menu option and click
“Create” in the toolbar at the top of the screen
4.7.3.1.1.2. For “Assay Name” enter “O157_Fragtest” and from the “Application Type”
drop-down menu select “Fragment”. Under the “Protocols” heading make sure
“No” is selected for assigning multiple instrument protocols.
4.7.3.1.1.3. Next to “Instrument Protocol” select the “Create New” button. A new
window will appear.
4.7.3.1.1.3.1. From the “Dye Set” drop-down menu select “DS-30”
4.7.3.1.1.3.2.  For “Run Module” select “FragmentAnalysis50_POP7x]”
4.7.3.1.1.3.3. An alert window will pop up asking if you would wish to assign a
protocol name. Click “Yes” and next to “Protocol Name” replace the ‘_1’
with *_2’ (i.e. - FragmentAnalysis50_POP7xl1_2). Use the default values for
all other parameters. This will create a new protocol with the specified
criterion.Under “GA Instruments”, click on + to expand “ga3500”
subfolders
4.7.3.1.1.3.3.1. NOTE: These are the instrument default running
conditions for Fragment Analysis with a 50 cm capillary
array and POP7 polymer. You can check the running
conditions by clicking the “Library” button at the top
right of the dashboard and then selecting the “Assays”
menu option on the left-hand side of the screen. The
default conditions are:
e Oven_Temperature: 60°C
PreRun_Voltage: 15.0 kVolts
Pre-Run-Time: 180 sec.
Injection_Voltage: 1.6 kVolts
Injection_Time: 15 sec.
Data_Delay_Time: 1 sec.
Run_Voltage: 19.5 kVolts
Run time: 1330 sec.

4.7.3.1.1.3.4. When finished, click on “Save to Library” and click “Yes” in the pop-
up window that asks to apply the changes to the assay. Click “OK” to
confirm, and then close this window.
4.7.3.1.1.4. Next to the “Sizecalling Protocol” option select the “Create New” button.
4.7.3.1.1.4.1. Inthe new window enter “O157MLVA” as the “Protocol Name”.
4.7.3.1.1.4.2. From the “Size Standard” drop-down menu select “GeneFlo625”
4.7.3.1.1.4.3. Input the following analysis settings:
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Analysis: Full Range
Sizing: Partial Sizing
Start Size: 50
Stop Size 625
Size Calling Method: Local Southern Method
Primer Peak: Present
Minimum Peak Height:
o Blue: 600
o Green: 600
o Yellow: 600
o Red: 20
o Uncheck Purple and Orange
e Smoothing: none
Baseline window: 51 pts
Min. Peak Half Width: 2 pts
Peak Window Size: 21 pts
Polynomial Degree: 2
Slope Threshold Peak Start: 0.0
Slope Threshold Peak End: 0.0

4.7.3.1.1.4.4. Click on “Save to Library” and “Yes” to apply to the assay. Select “OK”
to confirm and close this window when finished.

4.7.3.1.1.5. Once all protocols have been established for the new assay, click “Save” and

close the window to return to the “Library” main screen.
47.3.1.2. File Name Conventions

4.7.3.1.2.1. Access the “File Name Conventions” menu on the left-hand side of the
screen. In the toolbar at the top of the screen select “Create”.

4.7.3.1.2.2. In the window that appears enter “MLVA” next to “Name”.

4.7.3.1.2.3. Use the default settings and click “Save” and close the window.

4.7.3.1.3. Results Groups

4.7.3.1.3.1. Access the “Results Groups” menu on the left-hand side of the screen. In the
toolbar at the top of the screen select “Create”.

4.7.3.1.3.2. In the window that appears, enter “O157results” as the name for this results
group.

4.7.3.1.3.3. Under the “Delimiters” section heading click the “Add” button to insert a
dash in the “Selected Attributes” box on the right-hand side of the window.

4.7.3.1.3.4. From the “Available Attributes” list, scroll down to “Plate Name”. Select it
and click the “Add” button in between the two boxes to add it to the “Selected
Attributes” list.

4.7.3.1.3.5. Uncheck the “Include an Instrument Run Name folder” and “Include an
Injection folder” options, keeping all other default parameters.

4.7.3.1.3.6. Save this results group to the library and close the window.

4.8.Genetic Analyzer 3500 instrument preparation before each run
4.8.1.DAY 1
4.8.1.1. Make sure service console is open and all components are green.
NOTE: Make sure a capillary array is installed in the instrument. For
installation, follow the instructions of the “Install Capillary Wizard”. You
can find the wizards by expanding the 3500 subfolder by highlighting
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“Manual Control”. The “Wizards” drop-down menu will appear on top of the
window.
48.1.1.1. NOTE: The RFID tags on the packaging of the consumables
automatically log in the hours spent on the instrument. The run will not
start with expired reagents with the exception of an expired polymer
4.8.1.2. Go back to the dashboard screen by clicking the “Dashboard” button at the top left of
the screen
4.8.1.3. Select the “Create New Plate” icon at the top of the screen. Name the run following
the standardized PulseNet naming system: use the unique identifier code that was
assigned to your laboratory by PulseNet for the first two to four letters of the file name.
The next two spaces will indicate the year and the next four spaces will indicate the
month and the date the run was performed. For example GA070426 is a run made at the
GA Public Health Laboratory on April 26, 2007. If several runs are performed the same
day, separate the file names by using sequential numbers, for example GA070426-1,

GA070426-2.
4.8.1.4. From the “Plate Type” drop-down menu, select “Fragment”
4.8.1.5. Type in the Owner name or initials

4.8.1.6. Use the default settings (50cm array, POP-7 polymer) for the rest of the options and
click on the “Assign Plate Contents” button at the bottom of the screen.

4.8.1.7. The plate view screen will appear

4.8.1.8. Here you can type in the sample IDs or import a sample plate file from a template
(see Appendix PNL28-5 for instructions on importing plate .txt files).

4.8.1.9. To assign the Assay to the plate, proceed as follows:

4.8.19.1. Click on “Add from Library” in the “Assays” box at the bottom of the screen.

4.8.1.9.2. In the new window select “O157_Fragtest” from the list of assays.

4.8.1.9.3. Add this assay by clicking on the “Add to Plate” button, and then close the
window.

4.8.1.10. Adding the File Name Conventions (MLVA) and Results Groups (0157results) can be
done in the same manner, by selecting the “Add from Library” link in the respective
boxes.
4.8.1.11. Once the assay, file name convention and results group have been added to the
plate, select the entire sample ID set by highlighting the individual cells or by clicking on
column/row headings.
4.8.1.12. Check the box next to each of the run parameters: Assay, File Name Convention, and
Results Group.
4.8.1.13. When each of the run parameters have been successfully assigned a dot will appear
in the center of the cells in which the parameters were applied.
4.8.1.13.1. NOTE: If a plate layout has been imported from a .txt file the
Assay, File Name Convention and Results Group should automatically
be applied to the plate and check-marked for all samples.
4.8.1.13.2. NOTE: What identifiers are shown in the sample ID cells can be
changed by selecting or deselecting options in the “Show In Wells”
drop-down menu above the sample plate layout. Assays, file name
conventions, and results groups can be color coded by double-clicking
the black dot to the left of the file name or during initial setup.
4.8.1.14. Save the plate by clicking the “Save Plate” button in the toolbar at the top of the
screen and selecting “Save” from the drop-down menu.
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4.8.1.15. Go back to the dashboard screen by clicking the “Dashboard” button in the top left
corner of the screen and continue with fragment analysis preparation.
4.8.1.16. Ifneeded, install the POP7 polymer in the instrument.

4.8.1.16.1. Click on the “Maintenance” button in the toolbar at the top right of the
window, and then select the “Maintenance Wizards” menu option on the left-hand
side.

4.8.1.16.2. Follow the instructions of the “Replenish Polymer” wizard.

4.8.1.17. If needed, also install new anode and cathode buffer containers

4.8.1.17.1. NOTE: if an old polymer pouch (been on the instrument > 7 days)
is switched to a new one follow the instructions of the “Wash Pump
and Channels” wizard instead. A conditioning pouch will be required
for this process.

4.8.1.17.2. NOTE: To update the system after new reagents have been
installed, click the “Refresh” button under “Consumables Information”
on the Dashboard.

4.9. Fragment analysis sample preparation
4.9.1.DAY 1

4.9.1.1. Thaw the Hi-Di Formamide, the GeneFlo 625 DNA size standard and the internal

ladder (see appendix PNL28-4) and place on ice.
49.1.1.1. NOTE: aliquot Hi-Di Formamide (500 ul / tube) and the size
standard (50 ul / tube) in order to avoid frequent freeze-thaw cycles.

4.9.1.2. Prepare a 96-well V-bottom plate for diluting the PCR reactions. Using a 200 pl
multichannel pipettor and a solution basin, dispense 19 pl of molecular-grade water in
the required number of wells.

4.9.1.3. Remove the plate / tubes with the PCR reactions from the thermocycler. Briefly spin
down the plate / tubes, if necessary. Use a 10 pl multichannel pipettor to transfer 1 pl of
each PCR reaction directly across to the corresponding set of wells in the dilution plate.
In order to avoid cross-contamination, remove the strip cap from just one column ata
time and recap the column before opening the next one.

4.9.14. Add 3 pl of internal ladder in two wells.

4.9.1.5. Using a 200 pl multichannel pipettor, mix the dilutions by pipetting up and down a
few times. Cover the plate with parafilm and put in the fridge or on ice.

4.9.1.6. Prepare a fragment analysis master mix containing DNA size standard and Hi-Di
Formamide for the samples following the calculations indicated in the table below. The
fragment analysis mastermix calculations can also be performed using the autocalculate
box at the bottom of the PCR template worksheet (see appendix PNL28-2. Vortex briefly
and place onice.

Reagents Fragment analysis mastermix

Hi-Di Formamide 8 ul x (#samples +3)=

GeneFlo 625 bp size standard | 1 pl x (# samples +3)=

4.9.1.7. Place a MicroAmp Optical 96-well sample plate in a cold block. Aliquot 9 pl of the
prepared fragment analysis mastermix to the required number of wells. Cover the plate
loosely with Parafilm.
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4.10.

4.9.1.8. Using the 10 pl multichannel pipettor, add 1 pl of 1:20 diluted PCR reactions to the
appropriate columns in the sample plate. Keep sliding the Parafilm sheet from column to
column to keep track of the sample order.
4.9.1.9. Denaturate templates by heating the reaction plate uncovered in a thermocycler at
95°C for 3 min.
4.9.1.10. Manually turn on the oven of the 3500, by using the Command options under the
Manual Control submenu to change the set point to 60°C.
4.9.1.11. While the templates denaturate, prepare 30 ml 1X running buffer:
49.1.11.1. Add 3 ml of 10X Genetic Analyzer buffer in a 50 ml conical tube
49.1.11.2. Add purified water to bring the total volume up to 30 ml
49.1.11.3. Mix well by inverting
4.9.1.12. Briefly spin down the sample plate to remove any air bubbles
4.9.1.13. Place the sample plate in a plate base. Seal the plate with the rubber septa. Snap the
plate retainer onto the plate and the plate base.
4.9.1.14. Place the plate assembly and the buffer into the Genetic Analyzer 3500.

49.1.14.1. Push on the tray button at the front of the Genetic Analyzer 3500 to bring
the autosampler to the forward position. Open the instrument doors.

4.9.1.14.2. Place the plate assembly on the autosampler in position A or B with the
notched end of the plate base away from you

49.1.14.3. Add 1X running buffer to the anode and cathode reservoirs

4.9.1.14.4. Add distilled water to the waste and rinse reservoirs

4.9.1.14.5. Close the instrument doors and wait for the green light to illuminate

4.9.1.15. Start the run after making sure the system status is green.

4.9.1.15.1. Expand 3500 computer name icon.

4.9.1.15.2. Highlight “Run Scheduler”

4.9.1.15.3. Click on “Find All”

4.9.1.15.4. Highlight the plate name for the run

4.9.1.15.5. Link the plate by clicking on the yellow squares on the right side of the
window

4.9.1.15.6. The “Start Run” button will turn green indicating that the run can be started.
Click on this button, and then click “OK” on the alert window. The run will start.

Data export from the Genetic Analyzer 3500

4.10.1. DAY 2

4.10.1.1. NOTE: Steps 4.10.1.3 and 4.10.1.4 only need to be performed before the
very first analysis.
4.10.1.2. Double-click on the shortcut icon for GeneMapper v.4.0 and enter the appropriate
password to access the software. The main menu window will open.
4.10.1.3.  Set up the size standard:
4.10.1.3.1. From the “Tools” drop-down menu, select “GeneMapper Manager”. A
“GeneMapper Manager” window will open.
4.10.1.3.2. Select the “Size Standards” tab
4.10.1.3.3. Click on “New”, leave the default option “Basic or Advanced” checked and
click “OK”. “Size Standard Editor” window will appear.
4.10.1.3.4. Name the new size standard “GeneFlo 625”
4.10.1.3.5. Leave the default option “Red” as “Size Standard Dye”
4.10.1.3.6. Enter sizes for each peak in the table table (refer to the GeneFlo 625 product
insert for the peak sizes)
4.10.1.3.7. When finished, click “OK”.
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4.10.1.3.7.1. Click on “Apply”.
4.10.1.4. Set up analysis method:
4.10.1.4.1. From the “Tools” drop-down menu, select “GeneMapper Manager”. A
“GeneMapper Manager” window will open.
4.10.1.4.2. Select the “Analysis Methods” tab
4.10.1.4.3. Click on “New”, leave the default option “Microsatellite” checked and click
“OK”. “Analysis Methods Editor” window will appear.
4.10.1.4.4. Name the new method “0157MLVA” and click “OK”
4.10.1.4.5. Highlight the new method name “0157MLVA” and click “Open”
4.10.1.4.6. Select the “Peak Detector” tab and change “Peak Detection Algorithm” to
“Advanced” from the drop-down menu
4.10.1.4.7. Input the following analysis settings and click “OK” when finished:
e Analysis: Full Range
e Sizing: Partial Sizing
o Start Size: 50
o Stop Size 625
Smoothing: none
Baseline window: 51 pts
Size Calling Method: Local Southern Method
Peak Amplitude Thresholds
o B:600
G: 600
Y: 600
R: 20
P: 50
0:50
Min. Peak Half Width: 2 pts
Polynomial Degree: 2
Peak Window Size: 21 pts
Slope Threshold
o Peak Start: 0.0
o Peak End: 0.0
e Leave the “Enable Normalization” option unchecked

e o o o
O O O O O

4.10.1.4.8. Click “Done” to close the GeneMapper Manager window and return to the
main screen.

4.10.1.5. From the “File” drop-down menu select “Add Samples to Project”

4.10.1.6. Find the folder containing the data file to be analyzed: My Computer - AB SW &
DATA (D:) — Applied Biosystems — 3500 — Data — 0157results-<PlateName>

4.10.1.7. Highlight the desired file(s) and click on “Add to List”. File(s) will appear in the
window on the right. Click “Add” below the file list to return to the original screen.

4.10.1.8. Samples in the selected file(s) will be listed in a new window and the “Analyze”
(play) button appears in green color in the toolbar indicating that the files are ready to
be analyzed

4.10.1.9. Select the size standard GeneFlo 625 for the first sample, highlight the size standard
column, and select “Fill Down” from the “Edit” drop-down menu

4.10.1.10. Select the analysis method 0157MLVA for the first sample, highlight the analysis
method column, and select “Fill Down” from the “Edit” drop-down menu

4.10.1.11. Click the “Play” icon
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4.10.1.12. Name the project with the run name (for example, “GA070426") and click “OK”
4.10.1.13. A successful analysis is indicated by green squares. Yellow triangles indicate
problematic components (i.e. missing size standard peaks). Red circles indicate that
results fell below acceptable quality values. Samples with yellow or red circles in the SQ
column should be selected for re-analysis.
4.10.1.13.1.  Toresolve failed analyses due to sub-optimal molecular marker peak profile
(i.e. miscalling of peaks), select a row with a yellow triangle or red circle in the SQ
column and click on the “Size Match Editor” icon on the toolbar. “Size Match Editor”
view will appear.
4.10.1.13.2.  Place the cursor near the X-axis to activate the magnifying lens, and then pull
up (mouse left-click and hold) to zoom in a specific area to facilitate editing
4.10.1.13.3. Left-click at the base of a peak to select. Right-click and select “Add’,
“Delete”, or “Change”.
4.10.1.13.4.  Select the correct molecular weight for the selected peak from the drop-
down menu. Repeat this process for all other miscalled peaks. Click “OK” when
finished.
4.10.1.13.5.  After the size standard has been adjusted, click the “Play” button to re-
analyze the data. After a successful analysis, the samples will have green squares
under the SQ column. If the size standard cannot be adjusted, the reaction is
considered a fragment analysis failure and must be re-run
4.10.1.14. Check the fragment result data (the fluorescent peaks) for each well by highlighting
the well ID and by clicking on the “Display Plots” icon on the toolbar.
4.10.1.14.1.  Make sure that all seven VNTRs amplified in the EDL933 control and that the
fragment sizes are within the range specified in the appendix PNL28-2 and record
the fragment sizes on the PCR template worksheet.
4.10.1.14.2.  The size calling for the internal ladder should also be within the range
specified in the appendix PNL28-2 (or PNL28-4).
4.10.1.14.3.  Write down any failed reactions in the PCR template worksheet. Make a note
of non-specific bands and primer-dimers.
4.10.1.15. Export the peak file:
4.10.1.15.1. NOTE: the following columns should appear in the exported table
in the following order from left to right: “Dye/Sample”, “Sample file
name”, “Marker”, “Size”, “Height”, “Area”, “Data point”. The format of
the table can be modified by selecting “Table setting editor” from the
“Tools” drop down menu. Select the “Genotype” tab and make sure
that the boxes for the above mentioned columns are checked and no
additional boxes are checked.
4.10.1.15.2. NOTE: You can import the peak file also from the Data Collection
Foundation software, but the file format is not correct; the “Allele” and
“Marker” columns are missing and there are additional columns in the
file. This file cannot be imported into BioNumerics without first

manually modifying (adding and deleting appropriate columns) the file.
4.10.1.15.3.  Highlight the samples for which you want to export peak data
4.10.1.15.4.  Click on “Display Plots” icon on the toolbar
4.10.1.15.5.  Click on “Sizing Table” icon on the toolbar and a table will appear below the
electropherograms
4.10.1.15.6.  From the “File” drop-down menu, select “Export Table”
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4.10.1.15.7.  Select the location (for example a flash drive) where you want to export the
data
4.10.1.15.8.  Name the export file with the run name (for example GA070426) and make
sure the file type is tab-delimited text (.txt) file
4.10.1.16. The remaining gel can stay in the instrument if it is going to be used within seven
days
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Appendix PNL28-1

STEC 0157 MLVA PCR Primers

R1 Locus | Dye Forward Primer (5 to 3’) Reverse Primer (5’ to 3’)

VNTR-3 CalRed590 GG CGG TAA GGA CAA CGG GGT GTT TGA ATT G GAA CAA CCT AAA ACC CGC CTC GCC ATC G

VNTR-34 FAM GA CAA GGT TCT GGC GTG TTA CCA ACG G GTT ACA ACT CAC CTG CGA ATT TTT TAA GTC CC

VNTR-9 FAM GC GCT GGT TTA GCC ATC GCCTTCTTC C GTG TCA GGT GAG CTA CAG CCC GCTTAC GCT C

VNTR-25 | HEX GC CGG AGG AGG GTG ATG AGC GGT TAT ATT TAGTG ~ GCG CTG AAA AGA CAT TCT CTG TTT GGT TTA CAC GAC

R2 Locus | Dye Forward Primer (5’ to 3’) Reverse Primer (5" to 3’)

VNTR-17 | CalRed590 GC AGT TGC TCG GTT TTA ACA TTG CAG TGA TGA GGA AAT GGT TTA CAT GAG TTT GAC GAT GGC GAT C
VNTR-19 FAM GC AGT GAT CAT TAT TAG CAC CGC TTT CTG GAT GTT C GGG GCA GGG AAT AAG GCC ACC TGT TAA GC

VNTR-36 FAM GG CGT CCT TCA TCG GCC TGT CCG TTA AAC GCC GCT GAA AGC CCA CAC CAT GC

VNTR-37 | HEX GC CGC CCC TTA CAT TAC GCG GAC ATT C GCA GGA GAA CAA CAA AAC AGA CAG TAA TCA GAG CAG C

Primer sets are listed as multiplex PCR cocktails.
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Appendix PNL28-2

STEC Q157 MLVA PCR template and ARI workshee PCR nan date:
PCH instrumant
A B mun date
A B insnEnent
1 2 3 4 5 [ 7 B 8 10 11 12
A
B
C
i]
E
F
G
H
T coul CH T - Positlve L entrol (ELLU00)
__Irrnl m B of Famples only | H1 frgment sizes - R} fmgment nzes
WiNIR T
ma i 515 lot no. {159 - 1611
— 400 25 by bl o ‘h“‘-\\_
el bod Mo, -‘\“"""-..,__
BufTer ot mo.

&, ealr OIS - Tnlernal Ladder Tragmenl sipe
1. For cach isobis, Gll in an appeopeiate Biobumeries key numbsr for PCR reastions R and K2 (for cxample: Tod a0 isalate Exgrestod 510 Fangos Fragmem Sazm

D K1720 the BN key numbers are CDC_K1 THE] and CDC K1 720R2 127« 128 135 = 140
2, Fill in thee esxact by of fragment snalysis resaions (2 per isolste + controls) in the red b e aleady imeiuded 153 - 155 177-179
in caleulatson), Mix the Hi-Di Formamide snd 625 by sire standssrd in an apjeogeiate ube. Add S gl of mixhers to cach well 1172 — —
¥, Using a mulichannel pipettor, add 1 pl off 1:30 dluled PCR raction bowiells aontaining the Formamide'é25 b midure. 153 = 194 154 = 200

4. Denaturnte e plate at %5°C for 3 mim
4. Briefly spin down the plate.
6, Flage the plate = the plale base: cover wells wath o nebber septa finish the plile asembly Iy sapping on the plale retane

11 -2 160 - 262
h?' « 208 A3« R332
157 - 40l 433 - 415
530522 566 - B60
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Appendix PNL28-3
PCR Mastermix Calculations

NOTE: This is posted on SharePoint as an Excel file so users may save it locally, enter data, and use the auto calculate function.

Mastermix caleulations A l'lpﬂ']'ld ix PNL28-3

i b e of Feaotbong (+ 2 eotra), oarvenlly & red one, Bextio "Numb o 0s anslyzee” Tor autecalolstion.

Diece PCR reagents
VTR H0 Boffar
TR 55 gl
VHTER-J4F #TF
TR 3 PEgnum Tag

Lat fo.

Exp.

VNI -
W Eeaer
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Appendix PNL28-4

Instructions to prepare the internal ladder
1. Prepare DNA templates from isolates EC04PN0139 and EC04PN0570 as described in the
protocol step 4.5. Store the templates at -20°C or -80°C freezer.

2. Use the DNA templates to set up and run the PCR reactions R1 and R2 as described in the

protocol step 4.6.

3. After the PCR amplification, pool the R1 and R2 reactions for isolates EC04PN0139 and
EC04PNO0570 into one single PCR tube to gain a total volume of 40 pl.
4. Each new lot of internal ladder must be tested against the old ladder lot by running them in the

same fragment analysis run.

5. Store the ladder in -20°C or -80°C freezer. It should remain stable at least 5-6 freeze-thaw cycles

for a period of one month.

Expected fragment sizes (bp) of the fifteen fragments present in the internal ladder from smallest to the
largest in the order they appear in the electropherogram:

VNTR-36 (B)
VNTR-34 (B)
VNTR-19 (B)
VNTR-9 (B)

VNTR-25 (G)
VNTR-37 (G)
VNTR-17 (Y)

VNTR-3 (V)

170-172
222-224
297-298
520-522
127-128
193-194
153-155
397-401

260-262
320-322
566-569
138-140
199-200
177-179
433-435

Expected fragment sizes (bp) of the fifteen fragments present in the internal ladder by the dye in the order they

appear in the peak file:

VNTR-25 (G)
VNTR-17 (Y)
VNTR-36 (B)
VNTR-37 (G)
VNTR-34 (B)
VNTR-19 (B)
VNTR-3 (Y)

VNTR-9 (B)

127-128
153-155
170-172
193-194
222-224
297-298
397-401

520-522

138-140

177-179

199-200
260-262
320-322
433-435
566-569

NOTE: fragment sizes for the internal ladder based on independent runs on multiple instruments at CDC
and in PulseNet Participating Laboratories
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Appendix PNL28-5
Steps for exporting and importing plate set ups on the ABI 3500

Note: the procedure described below will require the sequencer computer to have
Microsoft Office. If the sequencer computer does not have Microsoft Office, the
exported file needs to be saved on a flash drive so that steps 8 through 15 can be
performed on a computer with Microsoft Office.

1. Onthe Dashboard screen click on the “Edit Existing Plate” button.

Select “Fragment” from the “Filter” drop-down menu.

3. Find the most recent full plate. Click on the ID to highlight the desired plate and then click the

“Open” button at the bottom of the window.

NOTE: If you do not have a full plate, create a new one by filling in each
sample ID space (AO1 through H12) with “test” and saving it with the plate
name “EC_Template”. Be sure to add the results group “O157results”, file
name convention “MLVA”, and Assay “O157_ Fragtest” to each sample, making
sure each one is check-marked. It is necessary to have all required wells filled
in when exporting so that they will be available in your exported file.

N

4. In the plate layout window, click the “Export...” button in the toolbar at the top of the screen.

5. Inthe export window, create a new folder on the desktop by clicking the “Desktop” icon on the
left side of the window. Find the ‘New Folder’ button in the toolbar at the top of the window and
name the new folder “MLVA Plate Setup”.

6. Save the file to this folder by using your new plate name (e.g. - CDC110726) and clicking “Save”.

7. A window will pop up letting you know that the plate has been successfully exported. Click
“OK”.

8. Click the “Close Plate” button in the toolbar at the top of the plate layout screen, and click “Yes”
to close without saving changes.

9. Minimize the 3500 program window and open the “MLVA Plate Setup” folder on the desktop.

10. Right-click your plate name, select “Open With” and in the submenu select Microsoft Office
Excel.

11. Sample IDs can be typed or copy and pasted from a separate Excel file into the spaces next to
the correct wells under the “Sample Name” heading.

NOTE: Do not change/delete any of the column headings. The fields must be in
the same format when importing as they were when exported. Additionally,
the software will not import the file if the sample IDs contain special
characters (e.g. - !, /, ), etc). You can use underscores and dashes.

12. The “Plate Name” should be changed to match the plate/file name, and initials should be placed
under the ‘Owner Name’ heading. The defaults for “Application Type”, “Capillary Length (cm)”,
“Polymer”, and “Number of Wells” should be used.

13. Once all of the IDs are inserted, make sure that for each sample ID and all controls, the assay is
“0157_Fragtest”, the results group name is “O157results”, the file name convention is “MLVA”,
and “Sample” is listed under “Sample Type”.

14. Under the “File” drop-down menu select “Save”.

15. A warning window will appear asking if the workbook should be saved in the “Text (tab-
delimited)” format. Click “Yes”.

16. Exit Microsoft Excel, clicking “No” when prompted to save changes.
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17.
18.
19.
20.
21.

22.

23.

24,

NOTE: The removal of additional spaces from lines in the .txt file after
modification in Excel may be necessary before importing into the “3500”
program. To do this, open the file in “Notepad” making sure the window is
opened in full screen. In lines 1, 2, and 4 remove any additional spaces after
the last character in the line or from the left side of the page. Once all spaces
have been removed from those lines, save the file by clicking “Save” in the
“File” drop-down menu and close the window.

Go to the ABI 3500 plate layout window by clicking “Create New Plate” on the Dashboard.

Enter in the name of the plate and from the “Plate Type” drop-down menu select “Fragment”.

Click on the “Assign Plate Contents” button at the bottom of the screen.

In the toolbar at the top of the “Plate View” screen, click the “Import...” button.

In the import window, navigate to the recently created plate under Desktop/MLVA Plate Setup.

Select the appropriate .txt file and click “Open”.

At this point an error message may appear asking if you would like to proceed. If you encounter

this message, click the “Proceed” button at the bottom of the window.

When the file has been imported, an alert window will appear stating that the plate “has been

successfully imported”. Click “OK”.

In the toolbar at the top of the screen click on “Save Plate” and from the drop-down menu select

“Save As”. Enter the plate name matching the name of the .txt file, and click “OK”.
NOTE: When importing a plate layout from a .txt file the Assay, File Name
Convention and Results Group should automatically be applied to the plate
and check-marked for all samples. If the .txt file does not contain the correct
assay file name (e.g. — the name is misspelled, etc.), the assay will not be
imported and the file name convention and results group will be imported but
not check-marked.

NOTE: For repeated use, plate templates can be created by exporting a plate
to the “MLVA Plate Setup” folder. Save the file as a tab-delimited text file with
“test” as the sample ID and with a new plate name (e.g. - “EC_Template”).
After you have filled out the information for a new run on the template, save
it in step 14 with the standardized run name (name (e.g. - CDC101020). Since
the Assay and Results Group are different for each MLVA assay (STECO157,
Salmonella Typhimurium, Salmonella Enteritidis, etc), separate templates
must be exported and saved accordingly.
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